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PREDSTAVITEV CILJEV ENOTE  

V vsakdanjem življenju in poslovnem svetu nas akcidenčne tiskovine spremljajo na vsakem 

koraku. V učnem gradivu bodo predstavljene različne akcidenčne tiskovine in njihova izdelava. 

Spoznal boš: 

Cilji: 

vrste akcidenčnih tiskovin in njihovo uporabo; 

celostno grafično podobo podjetja in priročnik celostne grafične podobe; 

pravila stavljenja različnih akcidenčnih tiskovin; 

izdelavo akcidenčnih tiskovin. 

 

S pomočjo učnega gradiva boš samostojno izdelal letno poročilo z elementi sporočilne grafike in 

tabelaričnega stavka. 

Cilji: 

uporaba in povezava znanj pridobljenih pri različnih strokovnih modulih; 

navajanje na projektni način dela; 

samostojna izdelava izdelka, njegova predstavitev in zagovor. 
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VRSTE AKCIDENČNIH TISKOVIN 

Vizitka je akcidenčna tiskovina z osebnimi podatki in podatki o zaposlitvi. Uporabljamo jo za 

lažje navezovanje osebnih in poslovnih stikov.  

Dopisni list uporabljajo podjetja in ustanove za medsebojno dopisovanje. 

Kuverta (pisemska ovojnica) se uporablja za pošiljanje tiskovin. 

Vabilo (spored) je tiskovina, namenjena povabilu na prireditev. Z njo obvestimo povabljenca o 

tem, kdo je prireditelj, kaj prireja ter kje in kdaj. 

Oglas podjetja in ustanove uporabljajo za ponujanje svojih izdelkov, storitev, z njimi iščejo 

delavce.  

Letak in plakat sta tiskovini, namenjeni javnemu obveščanju, oglaševanju, povabilu na 

prireditev.  

Katalog (cenik) je pregledna zbirka določenih del (tudi knjižnih, umetniških) ali predmetov 

oziroma prodajnih izdelkov; kadar so v katalogu objavljene tudi cene, tiskovino imenujemo 

cenik. 

Dokumentne in vrednostne tiskovine so trajnejše listine. Mednje prištevamo diplome, 

spričevala, denar, menice, čeke in podobno. 

Koledar je pregledna razporeditev dni v letu. 

Letno poročilo je namenjeno predstavitvi poslovnih rezultatov podjetja lastnikom (delničarjem), 

zaposlenim, poslovnim partnerjem in vsem, ki se za podjetje zanimajo. 

PONOVIMO  

Ali lahko na podlagi lastnih izkušenj navedeš vsaj še tri vrste akcidenčnih tiskovin in opredeliš 

njihov namen in uporabo? 

V pomoč naj ti bo tudi naslednje: 

Akcidenčne tiskovine so priložnostne, komercialne tiskovine, ki so stavljene po izdelanih 

osnutkih. 

Klasična akcidenčna rotacija za ofsetni tisk (slika 1) je namenjena za kakovostno tiskanje 

priložnostnih tiskovin, kot so prospekti, katalogi, revije. Zato se pogosto imenuje tudi revijalna 

rotacija. Štiri ali več tiskovnih členov deluje po načelu guma-guma, kar pomeni, da ni tiskovnih 

valjev. Trak papirja teče med dvema ofsetnima valjema, ki drug drugemu služita kot tiskovni 

valj. Za tiskovnimi členi je navadno plinski sušilnik za sušenje odtisov z vročim zrakom, potem 

pa zgibalnik z rezalnikom (Kumar, M. 2008). 
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Slika 1: Akcidenčna rotacija za ofsetni tisk (vir: Kumar, M. 2008, str. 307). 
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CELOSTNA GRAFIČNA PODOBA  

Osnova za stavljenje akcidenčnih tiskovin je celostna grafična podoba podjetja, za katero se 

tiskovine izdelujejo. Pravila uporabe elementov celostne grafične podobe so zapisana v 

priročniku za njeno izvajanje. 

Podjetja za izdelavo celostne grafične podobe običajno najamejo grafičnega oblikovalca. 

Grafična priprava za različne medije in izdelava najrazličnejših tiskovin ter drugih aplikacij pa je 

v domeni izvedbenikov – tudi medijskih in grafičnih tehnikov. 

V posameznih primerih lahko kreativni posamezniki sodelujejo tudi pri izdelavi celostne 

grafične podobe, zato moramo poznati osnovne elemente celostne grafične podobe: zaščitni 

znak, barve, tipografijo. 

Celostna grafična podoba je za vsako podjetje, društvo, trgovino itd. nekakšen začetek delovanja. 

Uvajanje nove podobe je običajno za podjetja znamenje sprememb. Nova podoba nastaja z zelo 

skrbnim načrtovanjem vodilnih v podjetju in kasneje oblikovalcev oziroma izvajalcev nove 

podobe. Največkrat se podjetja odločajo za novo podobo ob začetku svoje dejavnosti ali kadar je 

potrebna zamenjava ali samo preoblikovanje že obstoječe podobe. Dobra grafična podoba 

podjetja pripomore k boljšemu ugledu, resnosti, profesionalnosti podjetja, zato njeno prepogosto 

menjanje ni dobro, ker to ustvarja vtis negotovosti in neprepoznavnosti.  

Nova celostna grafična podoba nastaja s profesionalnim in koordiniranim delom med oblikovalci 

in podjetjem, ki želi novo podobo. Za dober končni rezultat, so potrebne različne faze: raziskave, 

študije, analize, pregled literature, raziskava že obstoječih sorodnih podjetij ter raziskava 

ustreznosti dosedanje podobe, predvsem z vidika ustreznosti dosedanjega zaščitnega znaka in 

imena. Definirati je potrebno osnovne cilje in želje naročnika. V podjetju se morajo dogovoriti, 

ali bodo obdržali obstoječe ime ali se bodo preimenovali. Podjetje, ki potrebuje novo podobo, 

vsekakor potrebuje izdelano poslanstvo in vizijo.  

Zaščitni znak  

Na začetku oblikovalci pripravijo zasnovo, skice ter nekaj osnutkov. Ko je 

vzpostavljena vez med ustrezno barvo, znakom, logotipom ter tipografijo v različnih 

pojavnostih, se pričnejo oblikovati aplikacije nove celostne podobe. Ko nova podoba zaživi, je 

potrebno izdelati tudi priročnik za njeno izvajanje. 

Zaščitni znak je najosnovnejši element celostne grafične podobe. Znaki in njegove oblike 

vzbujajo največ pozornosti, so najpomembnejši elementi celostne grafične podobe. Zaščitne 

znake uporabljamo za sporočilnost, za prikazovanje lastnosti in za označevanje izdelkov. 

Zaščitni znaki ali gesla, ki so služila za isti namen, obstajajo vsaj 5000 let (Mollerup, P. 1997). 

Zgodovinski zaščitni znaki so bili namenjeni bolj pošiljatelju kot prejemniku. Zgodovinske 
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zaščitne znake so uporabljali, da bi potrdili družbeno pripadnost: kdo je to in kdo to pravi, 

lastništvo: čigava last je nekaj, poreklo: kdo je to naredil. Ti prvi poizkusi so bili slikovni, takrat 

še niso uporabljali črk. K zgodovinskim zaščitnim znakom lahko prištevamo tiskarske znake, 

heraldične znake, monograme, žigosanje, keramične znake, prostozidarske znake.  

Žigosanje živali poznamo vsaj 5000 let (Mollerup, P. 1997). Kasneje se je le-to najbolj 

razmahnilo v ZDA, kjer so uvedli celo register. Znamenja sestavljajo črke, številke, podobe ali 

njihove kombinacije. Na sliki 2 vidimo žigosanega vola. S široko puščico, prikazano na sliki 3, 

so Angleži označevali svoje konje med stoletno vojno.  

 

Slika 2: Žigosan vol (vir: Mollerup, P. 1997, str. 27). 

 

Slika 3: Znak za žigosanje konjev (vir: Mollerup, P. 1997, str. 27). 

Starodavni keramični izdelki so bogat vir znakov. Na starogrških vazah so znaki trgovcev, ki so 

jih kupovali od lončarjev in jih prodajali na oddaljena tržišča. Na nekaterih so tudi lončarjevi 

znaki, primer vidimo tudi na sliki 4, na nekaterih so celo vpisane cene.  

 

 

Slika 4: Keramična znaka proizvajalcev LMARMI in FORTI (vir: Mollerup, P. 1997, str. 32).  

Srednjeveški prostozidarji so bili veliki graditelji. Bili so arhitekti, inženirji in izkušeni delavci. 

Že od 12. stoletja naprej so svoje osebne znake vklesali v kamen, da bi tako postali nesmrtni, da 

bi pokazali svoj ponos, obeležili svoje delo in dobili zasluženo plačilo. Ti znaki niso vsebovali 

črk, saj so poizkušali ohraniti skrivnostnost.  
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Grboslovje izvira iz sredine 12. stoletja (Mollerup, P. 1997). Heraldične znake so prvi uporabili 

križarji, ki jih je papež pozval na križarske vojne proti muslimanom. Znake so imeli na oblekah, 

ščitih, zastavah, ker so jih potrebovali za medsebojno prepoznavanje. Pomembne so bile tudi 

barve. Heraldične barve so rdeča, modra, črna, zelena, vijolična, srebrna in zlata. Po heraldičnih 

zapovedih je bela enaka srebrni, rumena pa zlati. Heraldični znaki na orožju prikazujejo motive 

iz rastlinskega, živalskega sveta, ročnih izdelkov ali izmišljene motive – mitološke živali. Na 

sliki 5 vidimo heraldični znak z značilnimi heraldičnimi barvami. Ta motiv (dva para škarij za 

striženje ovac) se prvič pojavi na kovancu iz danskega mesta Sakskøbinga približno leta 1320 

(Mollerup, P. 1997).  

 

Slika 5: Heraldični znak (vir: Mollerup, P. 1997, str. 22). 

Originalni grški naziv za monogram pomeni »enostavna črta«. Danes ta pojem razumemo kot 

obliko, ki jo sestavljajo začetnice osebnega imena. V zgodovini so jih pogosto uporabljali kot 

podpis, ker večina ljudi ni znala niti pisati niti brati. V srednjem veku so se podpisovali s križci. 

Nekateri notarji so vpisali navpično črto, podpisniki pa so dodali vodoravno. Francoski monarhi 

so se podpisovali z monogrami, ki jih je sestavljal križ, ki je imel v presečišču romboidni ščit. 

Monograme francoskih monarhov vidimo na sliki 6.  

 

Slika 6: Monogrami francoskih monarhov (vir: Mollerup, P. 1997, str. 24). 

Kmalu zatem, ko je sredi 15. stoletja Gutenberg začel s tiskanjem, so tiskarji začeli označevati 

svoje izdelke. Začetni znaki so bili vrezani v les ali kovino in natisnjeni na naslovni strani ali na 

koncu knjige. Barvi sta bili črna ali rdeča. Kasneje so jih nadomestile ilustracije in znaki 

založnikov (Mollerup, P. 1997). Prvi znani tiskarjev zaščitni znak je par ščitov iz leta 1457, 

prikazan je na sliki 7, pripadal pa je Fustu in Schöfferju (Možina, K. 2003). Tiskar Aldus 

Manutius je uporabljal zaščitni znak, prikazan na sliki 8, na katerem je okoli sidra ovit delfin. 
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Slika 7: Tiskarski znak Fusta in Schöfferja (vir: Mesaroš, F. 1985, str. 131). 
 

 

Slika 8: Zaščitni znak Aldusa Manutiusa (vir: Možina, K. 2003, str. 52). 

Razvrščanje zaščitnih znakov 

Znak in njegove oblike vzbujajo največ pozornosti in so najpomembnejši element celostne 

grafične podobe. Kvaliteta zaščitnih znakov ni vedno nujno nedvoumna in razločna, ponavadi pa 

sta ti dve lastnosti povezani. Črke v logotipih so lahko tako nenavadno oblikovane, da jih skoraj 

nihče ne obravnava kot črke. Razlago, ki obravnava zaščitni znak za deskriptivni znak, bi morda 

lahko kar pozabili in večini uporabnikov prikazali zaščitni znak kot abstraktni znak. Znake 

uporabljamo dosledno.  
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Zaščitni znak lahko sestavlja črka, več črk in slika, kar pomeni, da ga lahko uvrstimo v dva 

razreda. Ker si različni uporabniki razlagajo isti zaščitni znak na različne načine, pomeni, da 

lahko nek zaščitni znak razvrstimo na več načinov. Nekdo, ki pripada drugi kulturi, bo 

predstavljal ali razvrstil vsaj nekaj zaščitnih znakov povsem drugače.  

Glavni tipi znakov so: lingvistični, matematični, znanstveni in grafični (Repovš, J. 1995). V 

okviru celostne grafične podobe govorimo o grafičnem znaku. Kvaliteta in intenzivnost znaka 

kot dražljaja sta odvisni od oblike, velikosti in medsebojnih odnosov likovnih struktur, ki znak 

sestavljajo. Znaki imajo lahko neskončno število oblik, barv in pojavnosti. Grafične znake 

delimo na tipografske in slikovne znake.  

Tipografski znak je črka kot lingvistični znak ali pa sestavljenka iz več črk, lahko je monogram 

(Mollerup, P. 1997). Tipografski simbol je lahko tudi logotip podjetja.  

Monogram so začetnice imena podjetja, ki so izpisane z značilnimi črkami in so običajno 

izpisane svobodno brez uokvirjanja. Monogram za svoje prikazovanje uporablja podjetje Lisca 

in je prikazan na sliki 9.  

 

 

Slika 9: Monogram podjetja Lisca (vir: Repovš, J. 1995, str. 101). 

Izraz »logotip« izhaja iz grške besede logos in pomeni beseda. Logotip včasih predstavlja daljše 

znake in lahko čitljiva imena. Včasih pa se logotip nanaša na krajša imena, akronime ali 

okrajšave. Če oblika črk v logotipu predstavlja določeno podjetje ali izdelek zaradi neke vizualne 

podobnosti ali vzporednosti, potem je logotip utemeljevalni znak, če gledamo njegovo vizualno 

podobo. (Mollerup, P. 1997). V imenu Golfin, na sliki 10, je »o« dvignjen, da bi ponazoril 

žogico za golf v letu. Golfin je skupina sedmih golf igrišč. Zaščitni znak izraža naravo dejavnosti 

s svojo ikonizacijo: poskakujoči »o«, ki ponazarja žogico za golf v letu.  

 

 

Slika 10: Logotip podjetja Golfin (vir: Mollerup, P. 1997, str. 109). 

Včasih podjetje uporablja svoje polno ime skupaj z okrajšavami; včasih pa le okrajšavo. 

Skandinavska letalska družba uporablja polno ime in štiri okrajšave: Scandinavian Airlines 

System, Scandinavian Airlines, Scandinavian, SAS in SK. Na sliki 11 sta prikazani polno ime z 

okrajšavo in okrajšava.  
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Slika 11: Polno ime z okrajšavo in okrajšava SAS (vir: Mollerup, P. 1997, str. 110). 

Slikovni – simbolni znaki so podobe. Slikovne znake delimo na deskriptivne, abstraktne, 

najdene (kar tako) in kombinirane. 

Deskriptivni znaki so podobe ali posnetki stvarnega sveta. Namesto simboliziranja opisujejo to 

kar reprezentirajo (Mollerup, P. 1997). Znak ribe, ki predstavlja ribjo restavracijo, je podoba. 

Lahko pa je to maska, ki je znak za gledališče. Deskriptivni znaki se nanašajo direktno na objekt, 

podjetje ali določen izdelek. Odnos med simbolom in njegovim objektom je vzpodbuden. 

Deskriptivne znake hitreje prepoznamo. Njihove oblike so posnetki realnega sveta. Njihova 

pomenska struktura je stabilnejša in težje spremenljiva. Prav zaradi tega so simboli manj 

fleksibilni.  

Na sliki 12 vidimo deskriptivni znak podjetja Kreuzeckhof Milkcenter; podaljšana krava nazorno 

prikazuje, da gre za pridelavo mleka. Spada med deskriptivne znake. Športno društvo 

Kostanjevica na Krki prav tako uporablja deskriptivni znak, ki predstavlja športnika, znak je 

prikazan na sliki 13.  

 

 

Slika 12: Deskriptivni znak podjetja Kreuzeckhof Milkcenter (vir: Mollerup, P. 1997, str. 104). 

 

Slika 13: Deskriptivni znak ŠD Kostanjevica na Krki (vir: Tršar, M. za podjetje Ardi). 



   

 

12 

 

Abstraktni znaki zbujajo različen odziv ob dojemanju vsebine objekta, na katerega se nanašajo. 

Abstraktni znaki so zelo pogosti in zaradi svoje oblike veliko bolj fleksibilni (Repovš, J. 1995). 

Z razvojem in spreminjanjem podjetij je lažje spreminjati pomensko strukturo abstraktnega 

znaka kot deskriptivnega. Abstraktni znak podjetja, ki se ukvarja z izdelavo športne opreme 

Nike, je zelo prepoznaven abstraktni znak. Zaradi svoje prepoznavnosti se lahko pojavlja brez 

tipografskega znaka (slika 14), vendar je podjetje potrebovalo vrsto let, da smo si uporabniki 

znak zapomnili in se tako danes največkrat pojavlja brez tipografskega znaka.  

 

 

Slika 14: Abstraktni znak podjetja Nike (vir: Mollerup, P. 1997, str. 172). 

Tudi francosko podjetje za izdelavo avtomobilov Citroen uporablja abstraktni znak, prikazan je 

na sliki 15. Abstraktni znaki se najpogosteje uporabljajo v kombinaciji z logotipom, imenujemo 

jih kombinirani znaki.  

 

Slika 15: Abstraktni znak podjetja Citroen (vir: Mollerup, P. 1997, str. 108). 

Kombinirani zaščitni znaki so kombinacije različnih vrst znakov, ki se združujejo v nov znak. 

Najbolj pogosto se abstraktni znaki kombinirajo s tipografskim znakom ali deskriptivni znaki s 

tipografskim znakom. Slika 16 prikazuje abstraktni znak, kombiniran z logotipom podjetja Hill's, 

na sliki 17 pa je deskriptivni znak kombiniran s tipografijo in je bil uporabljen za svetovno 

prvenstvo v ribolovu za ženske. 

 

 

Slika 16: Kombiniran zaščitni znak: abstraktni znak in logotip podjetja Hill's (vir: zloženka za 
mačjo hrano podjetja Hill's). 
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Slika 17: Kombiniran zaščitni znak: deskriptivni znak in tipografija za svetovno prvenstvo v 
ribolovu za ženske (vir: Tršar, M. za podjetje Ardi). 

Najdeni (kar tako) znaki se nanašajo direktno na svoj objekt. Ti znaki so včasih prepoznavni na 

način, ki v resnici nima nič skupnega s podjetjem ali izdelkom, ki ga predstavljajo (Mollerup, P. 

1997). Zaščitni znak podjetja Shell, ki je prikazan na slik 18, lahko pojmujemo kot znak kar 

tako. Znak za Shell prikazuje prepoznavno školjko, ki pa neposredno nima nič skupnega z 

izdelki podjetja, katerega predstavlja. Posredno pa pomeni »čisto tehnologijo« v naftni industriji.  

 

 

Slika 18: Znak kar tako podjetja Shell (vir: Mollerup, P. 1997, str. 107). 

Podjetja lahko uporabljajo tudi dve različici, za svoje predstavljanje uporabljajo logotip ali znak. 

Mobil Oil uporablja obe različici: na sliki 19 je logotip s slikovnim znakom, ki prikazuje Pegaza. 

V enobarvni aplikaciji so rdeči »o« med modrima »M« in »bil« v logotipu nadomestili z »o«, ki 

ga predstavljata dva koncentrična kroga. Ravno tako podjetje Sinergy uporablja dve različici za 

svoje predstavljanje. V prvi ima kombinirani znak, ki je v obliki kroga, v krogu je črka i, v drugi 

različici pa uporabljajo samo logotip, v katerem je črka i tudi označena na podoben način; znak 

podjetja je na sliki 20.  

 

 

Slika 19: Kombiniran zaščitni znak (vir: Mollerup, P. 1997, str. 102). 
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Slika 20: Kombiniran zaščitni znak (vir: Tršar, M. za podjetje Ardi). 

Razvoj znaka 

Grafično oblikovanje skupne podobe kot tudi oblikovanje določene podobe pomenita neko 

dogajanje in rezultat le-tega. Vsak oblikovalski program se mora prilagajati spreminjajočim 

pogojem.  

Družba postaja vse bolj zapletena, zaščitni znaki pa so, kot je videti, čedalje bolj enostavni. 

Morda je to posledica spremenjenega okusa ali pa naraščajočega življenjskega tempa, v katerem 

je hitro prepoznavanje bistveno. Strokovnjaki na področju oblikovanja in v podjetjih čedalje bolj 

spoznavajo, da je enostavnost vrlina, da včasih manj pomeni več.  

Na sliki 21 je prikazan razvoj znaka podjetja Opel, ki je znano po izdelavi avtomobilov. Podjetje, 

ustanovljeno leta 1862, je najprej izdelovalo šivalne stroje, za svoje označevanje je uporabljalo 

monogram AO (slika 21 a). V začetku 20. stoletja so začeli izdelovati kolesa in v znaku se je 

pojavilo družinsko ime (slika 21 b). Šele nato je sledila proizvodnja avtomobilov, uporabljati so 

začeli znak v obliki očesa z družinskim imenom (slika 21 c), sredi dvajsetih let prejšnjega 

stoletja so uvedli proizvodnjo motornih koles in znak je postal okrogel, dopolnjen s strelo; znak 

so še naprej posodabljali in ga dokončno poenostavili leta 1987 (slika 21 d).  

 

 

Slika 21: Razvoj zaščitnega znaka podjetja Opel (vir: Mollerup, P. 1997, str. 102). 
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PONOVIMO  

Naštej nekaj podjetij, katerih zaščitne znake dobro poznaš. Na podlagi zgornjih opisov razvrsti 

njihove zaščitne znake in pojasni, zakaj so se ti vtisnili v spomin. Povprašaj sošolca/sošolko ali 

tudi on/ona pozna ta podjetja in njihove zaščitne znake.  

Barve  

Barve in kombinacije barv so pomembna oblika informacije, zato so barve tudi 

pomemben del zaščitnih znakov in celostnih grafičnih podob. Barve pripomorejo k večji 

prepoznavnosti, razlikovanju, berljivosti znakov. Pogosto pravimo, da je določen znak (logotip) 

dober, ker je prepoznaven tudi v črno-beli različici.  

V vsakdanjem življenju nas obdaja množica barv. Njihova prisotnost je tako samoumevna, da 

ponavadi ne razmišljamo o nastanku barv. Okolico, v kateri živimo, zaznavamo s čutili, s 

pomočjo katerih se človek nauči obdelovati informacije. Ta čutila skupaj z možgani in živčnim 

sistemom omogočajo nastanek občutkov, kot so vid, sluh, vonj, okus in tip. Najpomembnejše 

človekovo čutilo je vid (Kumar, M. 1993). Z njim zaznava ali ocenjuje obliko, velikost, razdaljo, 

gibanje, barvo, ton in svetlost. Toda vid deluje le v navzočnosti svetlobe, ki je izvor vseh barv. 

Barve so sestavni del vseh teles, ki jih zaznava naš vid.  

Dojemanje barv je posledica fizikalnih, fizioloških in psiholoških učinkov svetlobe. Fizika 

preučuje energijsko naravo svetlobe, fiziologija čutne procese, ki so potrebni pri gledanju oz. 

pretvarjanju svetlobne energije v barvne signale, ter psihologija dojemanje tistega, kar vidimo. Iz 

tega lahko sklepamo, da je oko čutilo, ki zaznava svetlobo, medtem ko občutek barve ali tona 

nastane, ko pride ustrezni signal v možgane. Svetlobi, ki povzroči neposredno zaznavanje tonov 

in barv, rečemo barvni dražljaj. Le-ta je lastnost predmeta. Očesu jo posreduje svetloba, ki jo 

predmet seva, prepušča ali odbija. Posledica le-tega v očesu je barvna valenca in zato pravimo, 

da je barvna valenca informacija o barvnem dražljaju (Kumar, M. 1993). Vendar ne barvni 

dražljaj ne barvna valenca ne posredujeta barve ali tona, kot ju dojamemo v možganih. Zato 

moramo uporabiti še tretji pojem, to je barvni vtis. Ta pomeni dojemanje barve ali definiranje 

končnega občutka. Omenjeni postopek dojemanja barv lahko opišemo tudi drugače. Ko žarki 

svetlobe padejo v oko, nastane na retini očesa barvna valenca zaradi barvnega dražljaja, ki je 

povzročil nastanek kemijskih reakcij in aktiviral barvne receptorje, v katerih so barvila, 

občutljiva za svetlobo glede na svojo spektralno sestavo in njihovo spektralno občutljivost. 

Retina je tanka plast živcev, ki prepletajo fotoreceptorje, ki jih delimo na čepke in paličice. V 

retini očesa je okoli 110-120 milijonov paličk in okoli 6 milijonov čepkov (Kumar, M. 1993). 

Le-te delimo na tri vrste, ki se med seboj ločijo po spektralni občutljivosti. Ko svetloba doseže 

mrežnico, povzroči razpadanje barvila v čutnih celicah oz. barvnih receptorjih. To sproži živčni 

dražljaj, ki po vidnem živcu odpotuje v vidno središče v zadnjem delu možganov, ki informacijo 

spremenijo v ustrezni barvni vtis, na podlagi katerega ljudje zaznavamo barve in različne tone.  
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Uporaba barve  

Z uporabo ustreznih barv dosežemo želene učinke. Zaradi učinkovite barvne kombinacije in 

barvnih kontrastov oblikovani znak lahko pritegne pozornost. Da bi dosegli najboljše rezultate, 

moramo poznati nekaj osnovnih izrazov za opisovanje barv: barvni krog, barvni kontrasti ter 

psihološki vpliv nekaterih barv.  

 
Psihološki vplivi barve 

Pri barvah in njihovem psihološkem pomenu lahko sklepamo, da je ta pomen odvisen od barvne 

zaznave in njenega vpliva na fiziološko stanje človeka ob barvah. Barve nam lahko posredujejo 

določene misli, vzbujajo določene čustvene odzive. Zato ima vsaka barva tudi psihološki vpliv.  

 

 

Črna je nasprotna beli in njej enaka po absolutni vrednosti. Črna je barva obsodbe, odpovedi, 

ničevosti sveta (Repovš, J. 1995).  

 

 

Siva je barva pepela in megle, barva žalosti in dolgočasja. Je najmanj barva med vsemi barvami. 

Je namreč mračna in motna barva, v kateri je popolnost bele že zamazana, moč črne pa 

oslabljena (Kovačev, N. 1997). Sivo povezujemo z dolgočasjem in drugimi turobnimi občutki. 

 
 
 

Bela je absolutna, pomeni odsotnost in vrhunec barv. Je barva vrnitve, simbol sveta in absolutna 

tišina. Bela je barva čistosti. Sončna bela je simbol razcvetele dnevne zavisti, ki grize v 

resničnosti (Repovš, J. 1995).  

 

 

Zelena je povezana z naravo, čustvenostjo, mirom in sočutjem. Deluje pomirjujoče. Je barva 

večne mladosti (Repovš, J. 1995).  

 

 

Oranžno najpogosteje povezujemo s plamenom ali z vulkanom. Simbolizira veselje, 

zrelost in rast, njene objektivne povezave pa so sonce, ogenj in sadje (pomaranče) (Kovačev, N. 

1997). 

 

 

Rumena je intenzivna, nasilna, ostra ali pa široka, najtoplejša, najbolj ekspanzivna barva, ki sili 

čez okvirje (Repovš, J. 1995).  

Bela 
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Rjava barva učinkuje na organizem pomirjujoče, vendar ga ne uspava. Spada med najmanj 

priljubljene barve (Kovačev, N. 1997).  

 

 

Modra je najgloblja, najčistejša, najhladnejša in najbolj nesnovna med barvami. Predmetom 

olajša oblike, jih odpira in razdira. Modra barva pelje v osvoboditev (Repovš, J. 1995).  

 

 

Rdeča je prva barva, ki jo je človek poimenoval (Kovačev, N. 1997). Zelo močna barva in so jo 

od nekdaj povezovali z življenjsko vitalnostjo in prizadevnostjo. Rdeča deluje vznemirjujoče in 

je najnasilnejša med vsemi barvami. Je indikator močne volje in velike samozavesti, pa tudi 

indikator jeze. 

Ljudje se močno razlikujemo po svojem odnosu do oblik in barv ter pri določanju njihove 

relativne strasti. Vendar vse, kar nas vsak dan obdaja, so barve in zato lahko zaključimo, da 

barve vplivajo na nas in naše fiziološko stanje. 

PONOVIMO  

O komuniciranju in naravoslovju tehnoloških procesov si se veliko naučil 

že v okviru modula grafični in medijski procesi, zato ti ne bo težko 

odgovoriti na naslednja osnovna vprašanja: 

Kateri trije dejavniki so potrebni, da nastane barvni učinek ali barvni vtis? 

Opredeli pojme: primarni svetlobni vir, sekundarni svetlobni vir, barvni dražljaj, barvna valenca, 

barvni vtis in nariši blokovno shemo, ki ponazarja nastanek barve. 

S katerimi izrazi opisujemo barve in na katere lastnosti se ti izrazi nanašajo? 

Barvni krog in barvne kontraste si spoznal pri umetnosti in grafičnem oblikovanju. Poišči sliko 

12-delnega barvnega kroga, ponovi osnove mešanja barv, naštej in opiši barvne kontraste.  

Katero izmed opisanih barv bi si izbral kot najljubšo? Ali svojo izbiro lahko povežeš tudi z 

opisom njenega psihološkega učinka? Poišči še druge informacije o barvah in njihovih 

psiholoških učinkih. 

 

 
http://www.cpi.si/
files/cpi/userfiles
/Datoteke/ucnag
radiva/tgp2008_
web.pdf 

http://www.cpi.si/files/cpi/userfiles/Datoteke/ucnagradiva/tgp2008_web.pdf
http://www.cpi.si/files/cpi/userfiles/Datoteke/ucnagradiva/tgp2008_web.pdf
http://www.cpi.si/files/cpi/userfiles/Datoteke/ucnagradiva/tgp2008_web.pdf
http://www.cpi.si/files/cpi/userfiles/Datoteke/ucnagradiva/tgp2008_web.pdf
http://www.cpi.si/files/cpi/userfiles/Datoteke/ucnagradiva/tgp2008_web.pdf
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Tipografija 

Poleg znaka in barve pomemben element celostne grafične podobe predstavlja izbor 

tipografije. Pojem tipografija izvira iz grških besed typos, kar pomeni žig, in graphein, kar 

pomeni pisati (Mesaroš, F. 1985).  

Črkovni slogi  

Pri celostni grafični podobi so črke pomemben vizualni element. Lahko se pojavljajo kot 

grafični, tipografski ali kombiniran znak. Uporabljamo jih tudi na različnih tiskovinah, kjer se 

nahajajo poleg znaka. Dobro poznavanje značilnosti črkovnih slogov nam omogoča lažjo, 

primernejšo izbiro in uporabo tipografije. Najbolj smiselna je razdelitev pisav v posamezne 

črkovne sloge oziroma skupine, sledeč zgodovinskim obdobjem, v katerih so nastale pisave 

(Možina, K. 2003).  

PONOVIMO  

Na spletu poišči učno gradivo Knjiga, Knjiga_1 in preberi poglavje 

Stavljenje besedila. Opise značilnosti črkovnih slogov pa lahko najdeš 

tudi s pomočjo ponujene povezave na spletno stran revije Grafičar. 

Svoje znanje lahko preveriš tudi na naslednji način: 

Izberi tri različne tiskovine, ki jih vsakodnevno opaziš, prebereš, si jih zapomniš … in jih opiši z 

vidika tipografije: 

Razvrsti jih. Ali je katera med njimi akcidenčna tiskovina? 

Zapiši podatke o: uporabljeni vrsti pisave, številu različic in stopenj pisave, naslonilih in 

tipografskem slogu, elementih celostne grafične podobe …  

Na podlagi zbranih podatkov o tiskovinah presodi, če so zanje izbrana ustrezna oblikovna 

sredstva in ali so upoštevana pravila stavljenja. 

S sošolcem/sošolko izmenjajta svoje ugotovitve. 

Priročnik celostne grafične podobe  

Vsako sodelovanje med izvajalci celostne grafične podobe in 

naročniki bi se moralo končati s priročnikom celostne grafične podobe. 

Vendar se za njegovo izdelavo naročniki pogosto ne odločajo, kajti ne 

zavedajo se dovolj njegove pomembnosti.  

 

  
Na svetovnem 
spletu poišči 
primere Priročnikov 
celostne grafične  
podobe ali pa si 
sposodi knjigo 
Jerneja Repovša. 

 
http://www.graficar.si
/tipografskigeslovnik.
htm 

 
 
 
 
CIP – Kataložni 
zapis o publikaciji; 
več lahko najdeš 
na: 
http://www.nuk.uni-
lj.si/nuk3.asp?id=3
88537233 
 
 
 
CIP – Kataložni 
zapis o publikaciji; 
več lahko najdeš 
na: 
http://www.nuk.uni-
lj.si/nuk3.asp?id=3
88537233 
 
 
 
CIP – Kataložni 
zapis o publikaciji; 
več lahko najdeš 
na: 
http://www.nuk.uni-
lj.si/nuk3.asp?id=3

http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
http://www.nuk.uni-lj.si/nuk3.asp?id=388537233
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Pri oblikovanju priročnika ni potrebno hiteti, kajti vsak element, pa naj bo tipografski ali barvni, 

je potrebno prilagoditi likovni površini in pri tem paziti tudi na tipografska pravila. V priročniku 

so opredeljeni vsi elementi, ki so del celostne podobe podjetja, ne samo zaščitni znak, barve in 

pisave v vseh svojih različicah, temveč tudi različne akcidenčne tiskovine ter aplikacije, ki se 

nanašajo tako na interier kot eksterier, kadar naročilo podjetja obsega tudi ta del celostne 

podobe. 

Priročnik je nekakšen zakonik, po katerem se ravnajo in ga tudi dosledno uporabljajo vsi, ki so v 

kakršnem koli stiku s podjetjem. Zaradi različnih podjetij in ustanov, ki imajo celostne podobe, 

se srečujemo tudi z različnimi priročniki, tako po vsebini kot tudi po obliki. Vendar so jim 

skupni nekateri elementi, ki predstavljajo osnovni del priročnika: zaščitni znak v barvni različici, 

zaščitni znak v črno-beli različici, zaščitni znak v negativu, konstrukcija znaka, tipografije, 

barve, akcidenčne tiskovine (vizitka, dopisni papir, kuverta), aplikacije (napisi na majice, napisi 

na transparente, zastave ...).  

STAVLJENJE AKCIDENČNIH TISKOVIN  

Tipografski slogi 

Tiskovine oblikujemo v petih tipografskih slogih. 

Sredinski ali simetrični slog je tipografska ureditev stavka, pri kateri so vse vrste in oblikovni 

elementi sprti na sredino. V tem slogu stavimo predvsem knjižne naslove klasičnih izdaj, 

znanstvenih knjig in nekatere priložnostne tiskovine (plakat, vizitka, vabilo, osmrtnica), ki 

morajo imeti miren in slovesen videz. 

Zaprti ali blokovni slog: glavne značilnosti tega sloga so togo, pravokotno oz. v bloku 

oblikovane skupine besedila. V tem slogu stavimo knjige, slovarje, leksikone, enciklopedije, 

časopise, revije. 

Elementarni ali konstruktivni slog je v  posameznih elementih obdržal togo obliko blokovnega 

sloga – posamezni deli besedila so postavljeni v samostojne bloke. Razporeditev besedila je sicer 

razgibana in razmerje med besedilom in belimi ploskvami je urejeno v zlatem rezu, vendar je 

celoten videz še vedno zelo tog; ta tipografski slog uporabljamo npr. za stavljenje vizitk. 

Prosti ali asimetrični slog se vse bolj uveljavlja. Besedilo, tudi daljše, stavimo v neenako dolgih 

vrstah, zato so presledki med besedami lepo izenačeni. Posamezne skupine besedila prosto 

razmestimo, paziti pa moramo na smiselno razporeditev skupin in na harmonijo med potiskanimi 

in nepotiskanimi ploskvami. 

Lokasti slog: s postavitvijo besedila na krivulje lahko dosežemo zanimive posebne učinke, ki pa 

se morajo ujemati z vsebino.  
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Vizitka 

Vizitko stavimo v simetričnem ali asimetričnem slogu. Lahko je pokončna ali ležeča, 

največkrat v velikosti od 8×4,5 do 9,5×6 cm (lahko je tudi večja ali manjša). Obstajajo tudi v 

obliki kvadrata, pravokotnika, elipse, polkroga, trikotnika, romba …  

Z največjo stopnjo črk stavimo ime in priimek. V primeru vizitke podjetja je največje stopnje 

ime podjetja, ime in priimek pa manjše stopnje. Še manjše stopnje je naslov in najmanjše poklic. 

Enake stopnje kot naslov stavimo še telefonske številke, številke faksa, naslove elektronske 

pošte. Pisanih črk se izogibamo, prav tako tudi posebnih akcidenčnih pisav.  

Vizitke so lahko enobarvne, dvo- ali večbarvne. Podatki so lahko napisani na eni ali obeh 

straneh. Izjemoma so lahko tudi štiristrane. Materiali, ki jih uporabljamo za vizitke so: karton 

(lahko ima reliefni vzorec), folija, usnje, plastični materiali. 

 

 

Slika 22: Simetrično stavljena vizitka (vir: Molek, I. za Učno gradivo). 

 

 

Slika 23: Asimetrično stavljena vizitka (vir: Molek, I. za Učno gradivo). 



   

 

21 

 

PONOVIMO  

Podjetja javno objavljajo razpise ali natečaje za izdelavo celostne grafične podobe in njenih 

elementov. 

V maju 2010 smo na Srednjo medijsko in grafično šolo Ljubljana prejeli naslednji dopis: 

Smo mlada ekipa ameriškega nogometa Werewolves in prihajamo iz Slovenske Bistrice. Ker 

veliko dajemo na našo zunanjo podobo in nasploh celostno podobo kluba, razpisujemo nagradni 

natečaj za izdelavo logotipa, ki naj bo kreativen in prepoznaven, za razliko od sedanjega, ki je 

bil narejen v zelo kratkem času in nima prepoznavnosti. 

Pišemo Vam z namenom, da bi objavili naš natečaj (natečajni razpis je v prilogi) pri vas, saj 

menimoo, da ste vi pravi naslov. Natečaj predstavlja tudi priložnost za vaše dijake, da grafično 

oblikujejo in nekaj zaslužijo. Za vsa morebitna vprašanja smo vam z veseljem na voljo na 

telefonski številki 040 431 087 (Aljaž) ali nam pišite na elektronski naslov info@werewolves.si. 

Lep pozdrav, 

Aljaž Jelen 

predsednik kluba 

 

Čeprav je natečaj že potekel, na osnovi priloženega razpisa izdelaj svojo različico logotipa. 

Primerjaj jo z logotipom, ki ga uporablja ekipa Werewolves, poišči ga na njihovi spletni strani. 

Za svoj najljubši šport (športni klub) izdelaj vse elemente celostne grafične podobe in 

priročnik za njeno izvajanje. 

mailto:info@werewolves.si.
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Dopisni list 

Dopisni list mora vsebovati zaščitni znak, naziv in dejavnost podjetja, kraj, ulico in 

hišno številko, telefonsko številko, naslov spletne strani in elektronske pošte. Večinoma vsebuje 

tudi matično številko, TRR številko, ID številko podjetja … 

Format je največkrat pokončni A4, tipografski slog pa večinoma asimetričen. Pisave 

uporabljamo v skladu z izdelano celostno grafično podobo podjetja oziroma jih izbiramo glede 

na dejavnost podjetja. 

Kuverta (pisemska ovojnica)  

Formati kuvert so standardizirani. Nanje natisnemo tiste 

podatke, ki jih potrebuje pošta, da pošiljko vrne, če ne najde naslovljenca. 

Besedilo tiskamo v zgornji levi rob, v primeru pogodbe s pošto se 

namesto znamke tiska besedilo: poštnina plačana pri … 

Veliko koristnih informacij o poštnih storitvah, standardnih velikostih in 

navodila za naslavljanje pošiljk lahko najdeš na spletni strani Pošte 

Slovenija. 

Vabilo (spored)  

Format vabil in sporedov je lahko zelo različen, glede na vrsto prireditve in obseg 

besedila. Za vabila uporabljamo podolgovate formate, sporedom bolj ustrezajo pokončni formati 

(10×22 cm ali manj).  

Pisavo izbiramo primerno vrsti prireditve. Za slavnostne prireditve izbiramo pisave renesančnega 

ali klasicističnega sloga, stavek pa oblikujemo simetrično. Za zabavne prireditve pa je 

primernejša asimetrična oblika in črke linearnih pisav. Sporede in vabila lahko tiskamo na 1 list, 

v tem primeru je druga stran prazna, ali na štiri strani. Pri štirih straneh pustimo prvo stran 

prazno ali tiskamo nanjo primerno slikovno gradivo, druga stran je lahko prazna, včasih pa nanjo 

tiskamo uvodno besedilo. Glavno besedilo sporeda je vedno na tretji strani, četrta je prazna ali 

izpolnjena z zaščitnimi znaki sponzorjev. Z izbiro velikosti in vrste pisave poudarimo naslov 

prireditve, vse ostalo besedilo stavimo iz enotnih črk, da dosežemo preglednost in miren videz 

tiskovine. Izogibati se moramo mešanju pokončne pisave s kurzivno, presledki med besedami 

morajo biti enakomerni. 

  
http://www.posta.
si/naslovnica2/45
4/Postne-storitve 
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Oglas  

Tipografska oblika oglasa je podrejena njegovemu namenu, vsebini in velikosti. 

Poudarimo predvsem zaščitni znak podjetja, ki oglašuje, slogan in predmet, ki naj pri bralcu 

vzbudi zanimanje. Oglasi v časopisih in revijah so pogosto uokvirjeni. Najpomembnejše besedilo 

stavimo v zgornjo tretjino oglasnega prostora in z njim pritegnemo pozornost. 

Letak in plakat  

Letaki se razlikujejo od plakatov predvsem po formatu in nakladi, običajno tiskamo 

letake v veliko večjih nakladah. Plakate tiskamo v večjih formatih in lepimo na reklamne deske, 

panoje, ki so razmeščeni tako, da jih opazi čim več ljudi, medtem ko letake delijo osebno, jih 

zatikajo za brisalce stekel na avtomobilih ipd. Formati za plakate se gibljejo med A3 ali B3 do 

A0 ali B0. Danes se pogosto uporabljajo plakati še večjih formatov, ki jih imenujemo plakati 

velikega formata (jumbo oz. billboard). Vsa oblikovna sredstva morajo biti tem velikostim 

primerna, torej dovolj velike in jasne črke, primerni grafični (slikovni) elementi, da bodo zbudili 

pozornost mimoidočega tudi z večje razdalje. Material in tiskarske barve morajo biti odporne na 

različne vremenske razmere. Razen plakatov, ki vabijo na klasične prireditve in razstave, so vsi 

drugi stavljeni asimetrično. Skupine besedila morajo biti razvrščene od leve proti desni, smotrno 

in pregledno. Ponavadi zadostujejo tri stopnje črk, največje stopnje je naslov prireditve. Pri 

večbarvnih plakatih tiskamo pod posameznimi skupinami besedila tonske ploskve, ki so lahko 

polne, rastrske, črtane, iz geometrijskih likov ali pa besedilo v negativu. 

 

 

Slika 24: Letak, 1. stran (vir: Molek, I. za Srednjo medijsko in grafično šolo Ljubljana). 
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Slika 25: Letak, 2. stran (vir: Molek, I. za Srednjo medijsko in grafično šolo Ljubljana). 

PONOVIMO  

Za predstavitev svojega poklica izdelaj plakat v formatu B3 (primer na sliki 26). Uporabi zaščitni 

znak svoje šole, slikovno gradivo, ki ponazarja značilnosti tvojega poklica in ga opiši. Pravilno 

pripravo slikovno gradivo, kajti plakat bomo tiskali v ofsetni tiskarski tehniki. Pri stavljenju 

izberi ustrezen tipografski slog, primerno vrsto, različice in stopnjo pisave. Razmisli s katerimi 

načini poudarjanja boš dosegel optimalno čitljivost besedila. 

 

Slika 26: Plakat (vir: Klemenčič, B. 2008; izdelek za 4. predmet poklicne mature). 
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Katalog (cenik)  

Katalogi in ceniki so tako različni po formatu, vsebini, namenu, vezavi in oblikovanju, 

da ni mogoče postaviti strogih pravil, kako morajo biti izdelani. Oblikovanje prilagodimo 

naročniku in namenu. Predvideti moramo format, število strani, način zgibanja, vrsto platnic in 

vezavo. Za knjižne, razstavne in umetnostne kataloge se največ uporabljajo pisave prvega 

sklopa, s tankimi in podebeljenimi potezami črk. Primernejši so ozki in pokončni formati. V 

katalogih, kjer so objavljeni stroji, pohištvo ali industrijski izdelki, se najpogosteje uporabljajo 

linearne ali egipčanske pisave, ki jih lahko uporabimo tudi v zvezi s sodobno umetnostjo. 

Dokumentne in vrednostne tiskovine  

Poznamo tri vrste diplom: znanstvene, priložnostne in športne. 

Za znanstvene diplome se uporabljajo pisave prvega sklopa, pogosto uporabljamo verzalke, 

besedilo stavimo sredinsko. Robovi morajo biti široki, saj diplome vstavljamo v okvire. Največje 

stopnje je naslov diploma, velikost prilagodimo formatu tiskovine, naslednja manjša stopnja črk 

se uporabi za ime in priimek osebe, ki se ji podeljuje diploma, vse drugo besedilo je iz enakih 

črk; manjšo stopnjo lahko uporabimo le za naslednje podatke: kraj, datum, mesto pečata, 

komisija, predsednik, člani. Za pečat in podpise moramo pustiti dovolj praznega prostora. 

Formati znanstvenih diplom se gibljejo med A3 in A2, te velikosti so primerne za stenski okvir 

ali tulec, če pa so v obliki mape, so lahko tudi v formatu A4. Diplome vedno tiskamo na najboljši 

papir ali karton. Naslov diploma ter ime in priimek diplomantaso lahko v drugi barvi. Pred 

ponarejanjem se ustanove zavarujejo z uporabo podtiska, ki mora biti v svetlejši, običajno 

posebni zaščitni barvi, da ne moti besedila. Motiv pa naj bi bil v skladu z dejavnostjo za katero 

se diploma podeljuje. 

Med priložnostne diplome (priznanja, pohvale) prištevamo razne častne, gasilske, obrtne in 

podobne. Te tiskamo v več izvodih in ne samo dva ali tri kot pri znanstvenih. Imena prejemnikov 

se včasih vpisujejo naknadno. Tudi pri priložnostnih diplomah je glavna vrsta naslov tiskovine 

(tj. Diploma). Postavljena naj bo v zgornji polovici; da ne bi bila previsoko si včasih pomagamo 

z vinjeto ali zaščitnim znakom. Nadaljnja vsebina so ime in priimek prejemnika, častni naslov, ki 

ga prejema in kdo mu ga podeljuje. Vse drugo besedilo je enako kot pri znanstvenih diplomah. 

Pod besedilom je tiskan ton ali pa je besedilo uokvirjeno. Uporabljamo elemente in barve, ki so 

značilni za stroko, obrt ali organizacijo. 

Športne diplome (priznanja, pohvale) so oblikovane bolj svobodno. Te nimajo ustaljenih 

formatov, pa tudi oblikovanje je lahko asimetrično. Vedno so tiskane večbarvno. Skoraj vedno 

potrebujemo športni motiv, ki simbolizira tisto športno področje, iz katerega se diploma 

podeljuje. 

Vsa šolska spričevala so trajne dokumentne tiskovine, čeprav so v bistvu obrazci za 

izpolnjevanje. Pod besedilom je vedno tiskan podton, simboliziran z grbi in podobnim. Na 
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mestih, kamor bodo vpisovali ocene, morajo biti postavljene azurirane (črtane) črte, da ni možno 

ponarejanje. Papir za spričevala mora biti trpežnejši, format je A4, če obsega spričevalo en list in 

A3, če je preganjeno. Podobno kot spričevala stavimo še rojstne in poročne liste, zavarovalne 

police; le da so nekatere od teh tiskovin tudi v manjšem formatu (npr. A5). 

Papir za vrednostne tiskovine (denar, menice, čeke in podobno) mora biti trpežnejši, format 

pa je precej manjši od drugih dokumentnih tiskovin. Razen denarja morajo biti vse druge 

tovrstne tiskovine izpolnjene in podpisane, šele nato dobijo ustrezno vrednost. Večinoma so 

večbarvne, pod besedilom je primeren podton, na mestu, kjer je predviden vpis podatkov pa 

postavimo varnostne črte. 

 

 

Slika 27: Primer pohvale (vir: Molek, I. za Učno gradivo). 
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Koledar  

 Na spletu poišči informacije o koledarjih (zgodovina, različno štetje časa …). Ali sam 

še uporabljaš koledar v tiskani obliki? 

Poznamo veliko število različnih koledarjev, zato ni pravih pravil, kako naj izpolnjujemo prostor, 

ki je namenjena za koledarski del. Besedilo in številke stavimo največkrat na levo, kar je najbolj 

naravno, ni pa nujno. Ker številk ne seštevamo, ni potrebno, da stavimo enice pod enice, ter 

desetice pod desetice, tako, da lahko uporabimo tudi sredinsko ali desno poravnavo. Nedelje in 

praznike vedno stavimo v drugi barvi, če pa je koledar tiskan v eni barvi, jih stavimo polkrepke 

ali obrisane. Dan mrtvih, 1. november, praviloma stavimo v črni barvi. Koledarski stavek 

vključuje akcidenčna in tabelarična dela. Pri delu moramo upoštevati, komu je koledar namenjen 

ter kakšno nalogo bo opravljal med letom. Glede na to, delimo koledarje na več vrst: 

po obliki (format, papir, vezava), 

po vsebini (letni, polletni, četrtletni, mesečni). 

Koledarje imamo v najrazličnejših oblikah in formatih, tiskane na razne vrste papirja, umetnih 

mas, pločevine ... Koledarski del je razdeljen od posameznega dneva na enem listu, tedna na 

dveh straneh, tedna na eni strani, štirinajst dni na eni strani, leta na eni strani … Prostor, ki ga 

imamo na voljo za vsako od teh možnosti je tako različen, da ne more biti pravil, kako mora biti 

koledarski del postavljen. 

Vsak datum sestavljajo tile podatki: 

zaporedna številka dneva v mesecu,  

ime dneva v tednu, 

pri nekaterih koledarjih pa še ime praznika ali lunina mena. 

PONOVIMO  

Pri modulu izražanje s sliko in zvokom si zagotovo posnel že veliko dobrih fotografij. Uporabi 

jih za izdelavo svojega stenskega koledarja. 
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LETNO POROČILO Z ELEMENTI 
SPOROČILNE GRAFIKE IN TABELARIČNEGA 
STAVKA  

Letno poročilo vsebuje poleg predstavitve podjetja, poročila direktorja in nadzornega sveta tudi 

podrobno poslovno in računovodsko poročilo ter poročilo revizorja. Iz letnega poročila je 

razvidno, kako je podjetje v določenem letu poslovalo in kako uspešno je bilo pri tem. 

Za izdelavo letnega poročila podatke, informacije, elemente sporočilne grafike, besedila in 

osnovne grafične elemente, skladne s celostno grafično podobo, dostavi naročnik oziroma 

vodstvo podjetja.  

Oblike predstavitve: 

akcidenčna tiskovina, 

multimedijska predstavitev, 

predstavitev na internetu. 

Medijski tehnik sodeluje pri oblikovanju in izdelavi letnega poročila, izdela načrt, grafično 

obdela in ustrezno pripravi prejete materiale za izbrano obliko predstavitve. Po potrebi sodeluje z 

grafičnim oblikovalcem, ki ga izbere podjetje. 

Kako oblikovati letno poročilo 

Kako je oblikovano letno poročilo, lahko presojamo z več vidikov, in sicer glede na 

splošni vtis letnega poročila, skladnost oblike z vsebino, doslednost in red v osnovnem 

oblikovalskem konceptu, skladnost naslovnice z notranjostjo, vsebino, preglednost in berljivost, 

tipografijo, grafe, tabele, preglednice in drug slikovni material. 

Splošni vtis letnega poročila 

S splošnim vtisom presojamo videz letnega poročila. Zanima nas, ali letno poročilo zbuja 

stabilno podobo kulture oziroma dejavnosti podjetja, ali je prijetnega videza in s tem spodbuja 

bralca k branju. Tako na primer lahko daje letno poročilo mednarodni pridih zaradi uporabe dveh 

jezikov. Pomemben je ritem poročila; dober je, ko so fotografije velike in enakomerno 

razporejene v poročilu. Pri splošnem vtisu sta pomembna tudi kakovost tiska in papirja. 

Skladnost oblike z vsebino 

Kreativni koncept besedila mora biti jasno izražen tudi v oblikovanju. Naj bosta vsebina in videz 

organska celota, njuna sporočilnost ima isti cilj. Primer: visokotehnološka vsebinska obravnava 

in prav taka zunanja podoba, mehka vsebinska obravnava in mehka oblikovalska obravnava, ne 

pa mehka vsebina in visokotehnološko oblikovanje.  

http://www.jh-lj.si/index.php?p=7&k=653
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Doslednost in red v temeljnem oblikovalskem konceptu 

V vsej publikaciji naj bo jasno izražen temeljni oblikovalski koncept. Načelo urejenosti 

elementov na straneh istega vsebinskega sklopa naj bo jasno razvidno, hkrati pa naj ne bo 

monotono ponavljajoče se s strani na stran. Prav tako je primerna tudi oblikovna usklajenost med 

posameznimi vsebinskimi sklopi, vendar z jasnim razločevanjem med posameznimi sklopi 

(poslovni del, računovodski del). 

Skladnost naslovnice z notranjostjo 

Naslovnica je povabilo k branju in napoved notranjosti. Odseva naj temeljni oblikovalski in 

vsebinski koncept, ki se izraža v vsej publikaciji, ali s skladnostjo ali s kontrastom. Posamezni 

sklopi naj kažejo umeščenost v isto publikacijo. 

Sestava letnega poročila 

Sestavo letnega poročila ocenjujemo po tem, ali njegova vsebina sledi logičnemu in sistemskemu 

zaporedju. To pomeni, da ima poročilo na začetku kratek povzetek in so finančni rezultati v 

zadnjem delu poročila skupaj s poročilom revizorske hiše. Pomembno je, da je poročilo 

razdeljeno na logične dele, bodisi geografske bodisi poslovne, ki odsevajo sestavo podjetja. 

Poročilo je dobro sestavljeno, če ima v logičnem zaporedju na začetku dosežke v preteklem letu, 

sledi mu poročilo predsednika uprave in navedba dejavnosti podjetja, zadnji del pa sta letno 

računovodsko in poslovno poročilo. Dosežki v letu na začetku poročila naj omogočajo kratko 

finančno primerjavo s prejšnjim letom. 

Preglednost in berljivost 

Vsebina letnega poročila naj bo jasno razčlenjena z oblikovalskimi prijemi. Glavno besedilo naj 

bo postavljeno tako, da bo hitro berljivo, paziti je treba na tipografijo, stopnjo pisave, širino 

stolpcev in drugo. Hierarhija naslovov, podnaslovov in poudarkov naj bo nedvoumna skozi vso 

publikacijo. Spremna in dopolnilna besedila naj bodo z oblikovalskimi sredstvi jasno oddaljena 

od osrednjega besedila. V računovodskem poročilu sta bistveni preglednost in lahka dostopnost 

podatkov. Ta del publikacije naj ne bo neprivlačen privesek k oblikovalcem prijaznejšemu 

poslovnemu poročilu, saj gre za jedro publikacije. Dobrodošla so vsa sredstva, ki poleg večje 

preglednosti stranem s preglednicami in komentarji vdihnejo tudi likovno vsebino. 

Izbira tipografije 

K večji urejenosti publikacije brez dvoma pripomore pravilna izbira vrste pisave. Običajno je 

mogoče doseči vse hierarhične odtenke posameznih ravni besedila že z uporabo ene same širše 

družine črk (tanke, navadne, krepke, ekstra krepke in kurzivne različice), še posebej ob 

stopnjevanju velikosti črk in morda tudi barve. Kadar pa se v publikaciji prepletata strožja in 

mehkejša raven besedila, je uporaba dveh tipografskih družin zelo primerna. Tako je lahko 

značaj posamezne vsebinske ravni podkrepljen tudi z obliko črk. Seveda imajo vsa pravila tudi 

izjeme. (Hipotetični primer: letno poročilo denimo tiskarne, ki za vsako poglavje uporabi 

drugačno tipografijo.) Grafi, tabele, preglednice, fotografije in ilustracije Vsekakor morajo biti 

pregledni in jasno berljivi. Tabele in preglednice naj bodo stavljene po tipografskih pravilih. 

Vključujejo naj se v temeljni oblikovalski osnutek publikacije. Jasno naj bodo ločene od 

preostalega slikovnega materiala, torej od fotografij ali ilustracij. Te so organski del celotne 

publikacije. S svojo sporočilnostjo in tipom izvedbe naj podpirajo vsebino in oblikovalski 
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koncept, ali s sozvočjem, metaforo ali kontrastom. Umestitev slikovnega materiala naj se podreja 

temeljnemu redu oblikovalskega koncepta. 

Tabelarični stavek 

Tabelarični stavek uporabljamo za zbiranje in prikaz podatkov in informacij na jedrnat 

in urejen način, kadar želimo bralcu prikazati le podatke, ne pa tudi njihovih grafičnih razmerij. 

Tabelarični stavek delimo v tabelarične obrazce, ki so namenjeni kasnejšemu vpisovanju 

podatkov, tabelarične razpredelnice in preglednice pa so v celoti že izpolnjene z različnimi 

podatki. 

Tabelarične obrazce vedno stavimo s črtami. Tabelarične razpredelnice pa stavimo s črtami ali 

brez črt (imenujemo jih preglednice; v njih je običajno glava razpredelnice s tanko črto ločena od 

vsebine). Razpredelnice s črtami delimo še na odprte (so brez okvirnic) in zaprte (so uokvirjene s 

štirimi okvirnicami). 

Spoznati moramo vsa imena posameznih delov in črt, ki jih uporabljamo pri razpredelnicah. 

Največ delov in črt ima zaprta razpredelnica, njeni glavni deli so prikazani na spodnji sliki. 

 

 

Slika 28: Deli tabele (vir: Molek, I. za Učno gradivo). 

Stavljenje tabel 

Glavi tabele določimo višino v skladu z obsegom besedila, paziti moramo, da ni med besedilom 

in prečnimi črtami premalo ali preveč prostora. Najlepše je, če so nad in pod besedilom optično 

približno 4 enote belega prostora. 

Pri določanju širine posameznih rubrik ni odločilen obseg besedila v glavi, marveč potrebni 

prostor za poznejše vpisovanje podatkov. Tudi pri popolnoma izpolnjenih razpredelnicah določa 
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širino rubrike vsebina. Vsebinsko enakovredne rubrike morajo biti enako široke, saj zaradi 

besedila v glavi ne sme biti pozneje vpisano besedilo v mreži preveč stisnjeno ali preveč 

razmetano. 

Besedilo v glavi stavimo sredinsko, v čelu in mreži pa na levo naslonilo. 

Izbira črt 

Za tabelarični stavek uporabljamo črte različnih debelin. Najlepše je, če je tabela postavljena iz 

samih tankih ali polkrepkih črt, vendar to pogosto ni mogoče, ker naročniki zahtevajo, da z 

različno debelimi črtami ločimo pomembnejše od manj pomembnih predelov. Kadar stavimo 

tabele iz različno debelih črt, moramo upoštevati naslednje pravilo: okvirnica ne sme biti tanjša 

od glavnice, glavnica ne sme biti tanjša od čelnice, čelnica ne sme biti tanjša od rubričnic in 

rubričnice ne tanjše od podrubričnic. 

Izbira črk 

V knjigah, brošurah, revijah, katalogih, cenikih itd. postavimo besedilo iz enakih črk, kot je 

postavljeno glavno besedilo, če je potrebno uporabimo manjšo stopnjo pisave. 

Na splošno je besedilo v tabelah bolje staviti iz črk pisav drugega sklopa, ker se črke teh pisav 

zaradi enostavnosti in enakomerno debelih potez bolje ujemajo s črtami v tabelah, kakor črke 

pisav prvega sklopa. 

Vse besedilo moramo postaviti iz iste garniture črk. Vse, kar je potrebno poudariti, naj bo za 

stopnjo ali dve večje, podrejeno primerno manjše. Ne smemo staviti z ožjimi ali kurzivnimi 

črkami, tudi razpiranju se izogibamo. Glava naj bo čim bolj enotno postavljena, brez vsiljivih 

poudarkov v besedah.  

Besedilo v glavnih rubrikah začenjamo z veliko začetnico, v podrubrikah pa z malo zaradi 

nadaljevanja besedila. 

Tabelarični obrazci 

Tabelarični obrazci so tabele, ki jih pozneje izpolnjujemo z določenimi podatki. Večinoma je 

besedilo tiskano samo v glavi, v vse druge prostore pa se podatki vpisujejo pozneje. Tabelarični 

obrazci imajo dva dela: glavo in mrežo, včasih pa tudi še čelo. 

Glava je zgornji del razpredelnice s tiskanimi naslovi pokončnih in prečnih rubrik. Glave, kjer so 

rubrike razdeljene tudi druga nad drugo, imenujemo dvojne, trojne ali večkratne glave. Mrežo 

sestavljajo navpične črte ali rubričnice in vodoravne črte ali prečnice. Čelo imenujemo tiskano 

besedilo v glavni rubriki, ponavadi na levi, včasih pa tudi na desni. 

Akcidenčne razpredelnice 

V tiskovinah, ki imajo reklamno naravo (prospektih, cenikih, katalogih …), lahko razpredelnice 

oblikujemo bolj svobodno, ni potrebno upoštevati vseh pravil, ki veljajo za knjižne 

razpredelnice. 

Velikost razpredelnice prilagodimo tiskovini, formati so zelo različni od ozkih in visokih do 

kvadratnih. 
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Črke so največkrat linearnega ali egipčanskega sloga, vendar lahko tudi drugačne od glavnega 

besedila. Velikost črk v razpredelnici je enaka ali manjša od glavnega besedila. 

Pri črtah skoraj ni omejitev, krepke lahko uporabimo tudi do 12 pt ali več. Včasih so krepkejše 

pokončne črte, drugič prečne, odvisno od učinka, ki ga želimo doseči. Pri stavljenju lahko 

uporabimo tudi samo pokončne ali samo prečne črte; prečnice optično razširijo razpredelnico, 

debelejše rubričnice pa povišajo. 

Tiskovine, v katerih so objavljene akcidenčne razpredelnice, so najpogosteje tiskane v barvah. 

Barve imajo naslovno ali tonsko naravo, odvisno od jakosti. Naslovno uporabimo za tiskanje 

naslovov razpredelnic, naslovov posameznih delov ali močnejših črt. Barve tonske narave pa 

lahko tiskamo pod celotno razpredelnico ali posamezne rubrike oziroma vrstice. Tonska ploskev 

pod rubriko stolpec povezuje, tonska ploskev pod vrstico pa izraziteje loči in poudarja. 

Preglednice 

Preglednice so tabelarične razpredelnice brez črt, kjer so razen glave vsi podatki tudi že 

izpolnjeni (vozni red, matematične tablice ...). Glavo ločimo od besedila s tanko črto, razmik 

med vrstami uskladimo z razmikom v besedilu. Glavo in rubrike stavimo na levo stran, številke 

na desno. Tako stavimo večinoma vse knjižne razpredelnice. Za ločevanje naslovov in podatkov 

lahko uporabljamo tudi podlaganje tonskih ploskev oz. rastriranje. 

Knjižne razpredelnice 

Knjižne razpredelnice imenujemo tiste, ki so objavljene v knjigah, revijah in brošurah. Oblika 

knjižne razpredelnice se mora prilagoditi obliki knjige ali revije, v kateri bo objavljena. To ne 

velja samo za format, temveč tudi za uporabo črt, črk in rastra za poudarjanje. 

Format prilagodimo formatu stavka za knjigo. Kadar je le možno, postavimo razpredelnico na 

isto širino, kot jo ima stavek knjige. Vedno to ni mogoče, saj bi bile včasih preveč razvlečene ali 

stisnjene, zato jih stavimo ožje, malo širše ali ležeče (besedilo beremo od spodaj navzgor). 

Stavljenje razpredelnic v revijah je lažje, ker lahko širino prilagajamo širinam stolpcev na strani 

(postavimo jo na širino enega, dveh ali več stolpcev in vmesnih presledkov). Po višini so 

razpredelnice visoke kot zrcalo strani. 

Črke morajo biti iz iste družine kot glavno besedilo, spreminjati smemo le velikost. Kadar je 

razpredelnica sestavni del glavnega besedila, je stopnja črk enaka, če pa le pojasnjuje besedilo, 

so črke za stopnjo do dve manjše. Za poudarjanje uporabljamo kurzivno ali polkrepko različico. 

V knjigah objavljene razpredelnice pogosto stavimo brez črt, kot preglednice. 

Izdelava tabel v programu InDesign 

Tabele se v InDesignu obravnavajo kot besedilo, zato moramo pred njihovo izdelavo 

vedno narisati okvir za besedilo. Tabelo lahko izdelamo različno: v okvir za besedilo se 

postavimo z orodjem za besedilo in iz menija Table izberemo funkcijo Insert Table. Na zaslonu 

se nam pokaže pogovorno okno Insert Table, v polje Body Rows vnesemo želeno število vrstic, 
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v polje Columns število stolpcev, v polji Header Rows in Footer Rows vpišemo število vrstic, ki 

jih potrebujemo za glavo in noge tabele; če smo predhodno že izdelali tabelo in smo ji naredili 

sloge, si želeni slog lahko izberemo v spustnem seznamu;  izberemo že natipkano besedilo in ga 

z uporabo funkcije Convert Text to Table iz menija Table pretvorimo v tabelo. V pogovornem 

oknu definiramo način razdelitve podatkov v stolpce in vrstice, pritisnemo OK in na zaslonu se 

prikaže tabela. Z nasprotno funkcijo Convert Table to Text lahko izbrano/označeno tabelo, 

stolpec, vrstico ali polje pretvorimo v besedilo, pri tem izberemo ustrezen način ločevanja 

podatkov in potrdimo s pritiskom na OK. 

Izdelani tabeli lahko določimo nekatere osnovne lastnosti. Dodajamo ji stolpce, vrstice, glavo in 

noge, nato določimo osnovne lastnosti stavljenega besedila v njej: naslonilo, vrsto pisave in 

stopnjo, odmike. Uporabljamo funkcije na paletah Table ali Control ali v priročnih menijih 

(pojavljajo se na zaslonu na mestih,  kjer z desnim klikom miške izberemo del tabele). Paleta 

Table je v delovnem prostoru; če ni prikazana, jo poiščemo v meniju Window 

(Window→Type&Tables). Paleta Control je pod menijsko vrstico, funkcije za oblikovanje tabele 

so vidne šele potem, ko je izbran določen del tabele. 

Tabele in polja urejamo zato, da bi imela tabela lep videz, da bi bila pregledna in da bi bili 

podatki v poljih prikazani čitljivo in po tipografskih pravilih. Tabele in polja urejamo s pomočjo 

funkcij v pogovornem oknu Table Options (Table→Table Options) in Cell Options 

(Table→Cell Options).  Pogovorno okno Table Options je razdeljeno na pet menijev:  Table 

Setup, Row Strokes, Column Strokes, Fills, Headers and Footers. Meni Table Setup; v prvem 

sklopu Table Dimensions najdemo funkcije, ki so tudi na paletah Table in Control; število vrstic 

(Body Rows), stolcev/rubrik (Columns), glave (Header Rows) in noge tabele (Footer Rows). 

Table Border je funkcija, s katero določamo debelino (Weight; v spustnem seznamu so 

vrednosti, s katerimi določamo debelino okvirnice, kadar vpišemo vrednost 0, bo okvirnica brez 

obrisa), obliko (Type), barvo (Colour), tonsko vrednost (Tint), barvo vmesnega polja (Gap 

Colour; kadar izberemo pikčasto, črtkano vrsto obrisa, lahko s pomočjo funkcije Gap Color 

izberemo vrsto barve vmesnega polja). Funkcija Preserve Local Formatting je aktivna, če smo 

okvirnico že urejali na primer na paleti Control, s potrditvijo funkcije program obdrži prejšnje 

nastavitve. V primeru, da je tabela vgrajena v besedilu, v polje Table Spacing dodamo vrednosti 

za odmik tabele od besedila. V spustnem seznamu Stroke Drawing Order lahko določimo 

stičišča oz. prekrivanje prečnic in rubričnic med seboj z okvirnico. 

Posamezna polja in vrstice urejamo s pomočjo funkcij v pogovornem oknu Cell Options 

(Tabele→Cell Options). S pomočjo nastavitev, ki so nam na voljo v pogovornem oknu, 

določamo lastnosti polj. Polja in njihovo vsebino lahko urejamo tudi s pomočjo palet Stroke, 

Swatches, Colour. Pogovorno okno Cell Options je razdeljeno na štiri menije: Text, Strokes and 

Fills, Rows and Columns, Diagonal Lines.  V meniju Text najdemo funkcije za oblikovanje 

besedila v polju tabele, lahko jih primerjamo s funkcijami Text Frame Options.  V prvem sklopu 

Cell Insets so orodja za odmik besedila. V polja Top (zgoraj), Bottom (spodaj), Left (levo) in 

Right (desno) vnašamo vrednosti, s katerimi določamo odmik besedila (dodajamo belino) od 

robov polja. V sklopu Vertical Justification s pomočjo funkcij padajočega menija Align 

izbiramo med štirimi različnimi navpičnimi poravnavami besedila: Top nam besedilo poravna na 

vrh polja, Center razvrsti besedilo na sredino polja, Bottom na dno in Justify čez vso višino polja. 

Z izborom funkcije Justify program vključi tudi funkcijo Paragraf Spacing Limit, s katero 
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določamo prostor med odstavki.  V sklopu First Baseline določamo položaja prve osnovne črte 

(črkovne črte), v spustnem seznamu Offset (odmik) je pet načinov izračunavanja položaja prve 

črkovne črte besedila v polju. V sklopu Clipping s potrditvijo funkcije Clip Contents to Cell 

določimo porezavo vsebine polja (npr. grafičnega elementa)  v polju tabele. V sklopu Text 

Rotation (rotacija besedila) funkcija omogoča rotacijo besedila v polju tabele za 0, 90, 180 ali 

270 stopinj. 

Izdelava zaznamkov in hiperpovezav 

Letno poročilo podjetja pogosto objavljajo tudi na svojih spletnih straneh. Pri pripravi letnega 

poročila lahko dokumentu v InDesignu dodamo zaznamke in hiperpovezave. 

Zaznamki 

Zaznamek je vrsta povezave, ki z značilnimi odlomki besedila omogoča lažjo navigacijo po 

dokumentih, izvoženih kot Adobe PDF. Zaznamki, ki jih naredimo v InDesignu, se v Acrobatu 

in Adobe Readerju pojavijo v zavihku Zaznamki (Bookmarks). Zaznamke v InDesignu izdelamo 

s paleto Bookmarks, poiščemo jo v meniju Window→Interactive→Bookmarks. Ponavadi so 

zaznamki naslovi ali podnaslovi v dokumentu. Naslov v dokumentu označimo in v meniju palete 

izberemo funkcijo New Bookmark, zaznamek se pojavi na paleti. Zaznamek nas prestavi na 

določeno stran v InDesignu, ko nanj dvakrat kliknemo. Ko izdelamo zaznamke in jih želimo 

pregledati v Adobe Readerju, pri izvažanju dokumenta v format PDF (File→Export ter v 

spustnem seznamu Save as Type izberemo funkcijo Adobe PDF, v pogovornem oknu ne smemo 

pozabiti označiti funkcije, ki omogoča prikaz zaznamkov (Bookmarks) (glej sliko 37). 

Hiperpovezave 

Ko datoteko iz InDesigna izvozimo v formata SWF ali PDF, lahko bralec uporabi hiperpovezave 

tako, da s klikom na povezavo preskoči na drug del besedila, v drug dokument ali na spletno 

stran. Vir je besedilo, okvir za besedilo ali grafični element, ki ob kliku aktivira hiperpovezavo. 

Destinacije so URL, datoteka, e-poštni naslov ali del besedila, kamor nas hiperpovezava 

prestavi. Vsak vir ima lahko samo eno destinacijo, več različnih virov pa lahko kaže na isto 

destinacijo. Hiperpovezavo izdelamo s pomočjo funkcij na paleti Hyperlinks 

(Window→Interactive→ Hyperlink). Izdelamo jo tako, da označimo besedilo, ki ga bomo 

spremenili v hiperpovezavo in iz menija palete Hyperlinks izberemo funkcijo New Hyperlink (ali 

z desnim klikom miške izberemo funkcijo Interactive→New Hyperlink). V pogovornem oknu 

New Hyperlink najprej v spustnem seznamu Link To izberemo vrsto hiperpovezave; na primer 

Page za prehod na izbrano stran v dokumentu, URL za prehod na spletno stran. V polju 

Destination izberemo destinacijo prehoda, pri izboru prehoda na spletno stran vpišemo spletni 

naslov. V polju Character Style v spustnem seznamu izberemo znakovni slog za hiperpovezavo, 

v polju Appearance pa videz hiperpovezave. Pri izvozu v format PDF moramo v pogovornem 

oknu označiti funkcije, ki omogočajo prikaz hiperpovezav (Hyperlink) (glej sliko 37). 

Izdelane dokumente, posamezne strani, objekte lahko izvažamo (shranimo) v številnih formatih 

in jih pozneje uporabljamo v katerem drugem programu, nižji različici ali kakem drugem 

InDesignovem dokumentu. Za izvoz izberemo ukaz File→Export. V pogovornem oknu, ki se 

pojavi na zaslonu v polju Save as Type, izbiramo med različnimi formati (število formatov v 

spustnem seznamu je odvisno od tega, kaj smo v dokumentu označili,  preden smo izbrali ukaz), 



   

 

40 

 

od najosnovnejših okvirjev za besedilo Text Only, formata *.rtf, bitnega formata *.jpeg, formata 

*.eps, *.xml ter seveda formata PDF, katerega tudi največkrat izdelamo in sicer s pomočjo ukaza 

Export (v gradivu je opis podan v poglavju: Izdelava PDF datoteke za tisk in splet). 

Sporočilna grafika 

Statistična grafika – diagrami, grafikoni, tabele, zemljevidi in celo obrazci, kontrolni 

seznami in prijavnice – predstavljajo informacije v obliki številk, besed in misli. 

Sporočilno grafiko uporabljamo za lažje in boljše razumevanje; oblika in prikaz sta odvisni od 

vsebine sporočila. V sporočilni grafiki navadno uporabljamo številke in razmerja med njimi, ki 

jih oblikujemo v slike. Sporočilna grafika bralce obvešča in pritegne pozornost h gibanjem, k 

primerjavam in organizacijski sestavi. Uporabljamo jo lahko za razvrščanje in povezavo 

podatkov glede na pomen, stališče in dogajanje. Diagrame, tabele in grafe je mogoče prikazati na 

zanimiv način. Sporočilna grafika se uporablja v tiskovinah, predstavitvah na svetovnem spletu 

in v drugih medijih. 

Grafikoni in diagrami 

Z grafikoni lahko hitro sporočimo primerjave, razmerja in gibanja. Za prikaz zaporedja in 

odnosov uporabljamo raje diagrame. Pri izbiri ustrezne oblike je treba najprej določiti namen in 

hkrati ugotoviti, s katerim grafom ali diagramom bomo bralcem ali gledalcem najučinkoviteje 

prikazali podatke. 

Okrogli (tortni) grafikoni najbolje prikažejo razmerje med celoto in deli, najučinkovitejši so, 

ko imajo malo rezin in so te velike. 

 

 

Slika 29: Okrogli grafikon (vir: Golob, L. za Učno gradivo). 

S stolpičnimi grafikoni prikazujemo primerjave. Zloženi stolpični grafikoni hkrati prikazujejo 

primerjavo in dele celote. 

Struktura dijakov po spolu 
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Slika 30: Stolpični grafikon (vir: Golob, L. za Učno gradivo). 

 

Črtni grafikoni predstavljajo gibanja. 
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Slika 31: Črtni grafikon (vir: Golob, L. za Učno gradivo). 

Organizacijski diagrami so najpogostejša oblika diagramov. Prikazujejo odnose podrejenosti in 

nadrejenosti oziroma odgovornosti. Diagrami poteka prikazujejo sosledje/zaporedje dogodkov. 

Diagrame uporabljamo za prikaz zaporedja in odnosov, sosledja dogodkov v odvisnosti od časa. 

S časovnimi trakovi prikazujemo zgodovinsko perspektivo. Diagrami so primerni tudi za prikaz 

ploščinskih razmerij (npr. tlorisi prostorov, prerezi izdelkov in zemljevidi). 
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Slika 32: Organigram (vir: Golob, L. za Učno gradivo). 

PONOVIMO  

Z uporabo programov MS Excel in MS Word je izdelava grafikonov in diagramov zelo 

preprosta. Programa si spoznal pri modulu Informacijsko-komunikacijska tehnologija. Še sam 

izdelaj različne grafikone in diagrame. Pazi da boš glede na namen izbral pravilno obliko. 

Izdelek v obliki projektnega dela  

 Značilnost izdelka v obliki projektnega dela je, da obravnava življenjske, praktične 

situacije s strokovnega področja in ima za dijaka določen praktični pomen. 

Osnovna značilnost projektnega dela je kompleksnost problema, ki ga ni mogoče obravnavati v 

okviru posameznega predmeta, temveč v povezavi prakse z več strokovnimi ali splošnimi 

predmeti. Projekt je praviloma enkratna celota dejavnosti oziroma aktivnosti. 

Vsak projekt ima naslov (ime), cilj, vire, sredstva, roke izvedbe, projektno skupino in vodjo 

projekta. Za projekt je značilno, da ima: 

skupne smotre in cilje, 

opredeljen začetek in konec, 

opredeljeno zaporedje med seboj povezanih aktivnosti. 

Faze projektnega dela: 

iskanje idej, 

načrtovanje izdelka, 

Šolska dijaška 
skupnost 

Predstavniki 
oddelkov 
1. letnikov 

Predstavniki 
oddelkov 
2. letnikov 

Predstavniki 
oddelkov 
3. letnikov 

Predstavniki 
oddelkov 
4. letnikov 

Mentor šolske 
dijaške skupnosti 



   

 

43 

 

izdelava izdelka, 

predstavitev in zagovor izdelka. 

Letno poročilo z elementi sporočilne grafike in tabelaričnega stavka 

Cilj je predstavitev poslovnih rezultatov podjetja lastnikom, zaposlenim, poslovnim partnerjem 

in vsem, ki se za podjetje zanimajo. 

Cilj dosežemo s prikazom informacij, ki ustrezajo naslednjim kakovostnim merilom: 

pomembnost, zanesljivost, primerljivost, razumljivost, popolnost, objektivnost, previdnost, 

pravočasnost.  

Navodila 

Za izdelek v obliki projektnega dela si izberi podjetje, ustanovo, klub oziroma področje 

dejavnosti, ki te zanima, in boš o tem lahko pridobil veliko zanimivih informacij. Izdelal boš 

letno poročilo z elementi sporočilne grafike in tabelaričnega stavka v obliki, primerni za tisk in 

objavo na spletu. 

Elementi izdelka 

Glede na izbrano področje dejavnosti izberi/izdelaj elemente njegove celostne grafične podobe: 

izberi ime, izdelaj zaščitni znak, določi primerne barve, vrste pisave, tipografski slog, načrt in 

zrcalo strani. 

Zbrane podatke o izbranem področju dejavnosti predstavi z najprimernejšimi elementi 

tabelaričnega stavka: razpredelnico ali preglednico. 

Za grafični prikaz podatkov izdelaj različne elemente sporočilne grafike: diagram in grafikone. 

Kriteriji za izdelek – akcidenčno tiskovino 

Format: A4 

Obseg: minimalno 12 strani + ovitek. 

Obseg besedila: najmanj 6000 znakov. 

Izdelani in uporabljeni morajo biti vsi elementi celostne grafične podobe. 

Izdelani in uporabljeni morajo biti vsi elementi tabelaričnega stavka in sporočilne grafike. 

Izvedba 

Izvedi prelom letnega poročila. 

Naredi poskusni odtis in ga oddaj lektorju in korektorju. 

Vnesi popravke in izvedi pregled dokumenta. 

Izdelaj obe PDF datoteki (za tisk in splet). 

Pripravi se na predstavitev in zagovor svojega izdelka. 

 

Pri delu si lahko pomagaš z odgovori na naslednja vprašanja in priloženim povzetkom: 

Kateri so standardizirani formati papirja?  

V katerem programu in na kakšen način boš za tisk pripravil slikovno gradivo? 
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Kateri program boš uporabil za prelom strani? 

Opiši potek dela v programu za prelom strani. 

Katero vrsto paginacije boš uporabil v letnem poročilu? 

V čem se razlikujeta lektura in korektura? 

Kako se razlikujeta izdelani PDF datoteki? 

Lastnosti dokumenta določamo na podlagi prejetega materiala, navodil in želja naročnika ali 

grafičnega oblikovalca. Prelom in oblikovanje strani potekata v programih za prelom strani, ki 

nam omogočajo kreativno in fleksibilno sestavljanje elementov (teksta, slik in grafike oz. risb) na 

posamezni strani publikacije. 

Izdelava PDF datoteke za tisk in splet 

Pred izdelavo PDF datotek moramo vedeti kakšne so zahteve naročnika, kje in za kakšen namen 

jih bo uporabljal. Poznati moramo osnovne značilnosti posameznega formata PDF, vedeti 

moramo ali bomo dokument barvno upravljali. Pri barvnem upravljanju moramo biti posebej 

pozorni, kako bomo izbrali nastavitve, dobro moramo poznati proces barvnega upravljanja.  

Barvno upravljanje v reprodukcijskem procesu obravnava modul grafični reprodukcijski sistemi, 

informacije so dostopne v učnem gradivu Barve, barvna metrika, barvno upravljanje. 

V InDesignu lahko izdelamo različne formate PDF datotek. Izdelamo lahko PDF datoteke, 

primerne za prenos po elektronski pošti, multimedijske PDF datoteke, ki vsebujejo 

hiperpovezave, interaktivne gumbe in zvok ali pa izdelamo PDF datoteke, primerne za tisk. V 

spustnem seznamu pogovornega okna Export Adobe PDF lahko izbiramo med različnimi 

vrstami vnaprej pripravljenih nastavitev za izvažanje (glej sliko 33). Vsaka je opisana v polju 

Description, poznavalci pa lahko pripravijo tudi pogovorno okno z lastnimi nastavitvami 

(File→Adobe PDF Presets→Define). 

High Quality Print je nastavitev izvoza za dokumente, ki se bodo natisnili s kakovostnimi 

tiskalniki za poskusni tisk. Ločljivost barvnih in večtonskih slik je 300 ppi, enotonskih 1200 ppi, 

grafični elementi obdržijo izvirne barvne opise. V dokument se vključijo vse pisave. 

PDF/X-3:2002, na podlagi formata PDF 1.3 dopušča uporabo grafičnih elementov s procesnimi 

barvami CMYK, posebne barve, elemente RGB z barvnimi profili in neodvisne barvne opise 

CIELAB.  
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Slika 33: Spustni seznam pogovornega okna Export Adobe PDF (vir: Molek, I. za Učno gradivo). 

PDF/X-3:2003, na podlagi formata PDF 1.4 dopušča tudi uporabo medijsko nevtralne definicije 

barv v neodvisnem barvnem prostoru CIELAB, zato pretvarjanje barv ni potrebno. Izberemo 

funkcijo No Color Conversion v polju Color. V polju PDF/X – Output Intent Profile pa 

izberemo tisti barvni profil, ki opisuje razmere, v katerih naj bo dokument natisnjen. Pretvarjanje 

barv in izdelava ustreznih barvnih izvlečkov poteka med procesiranjem na rastrskem 

računalniku. Seveda ne gre prezreti, da mora vse navedene možnosti podpirati tudi tehnološki 

proces, kateremu so dokumenti namenjeni. 

PDF/X-4, je glede barvnega upravljanja enak kot PDF/X-3, dopušča pa še uporabo transparenc, 

plastnic, grafičnih elementov v formatu *.jpeg2000 in pisav OpenType. V tehnoloških procesih, 

ki tega ne podpirajo, so ti dokumenti neuporabni, razen če jih ne pripravimo namensko, torej za 

določene razmere tiskanja v polju Color Conversion izberemo funkcijo Convert to Destination. 

Press Quality so privzete nastavitve, ki jih InDesign ponuja za dokumente Adobe PDF, ki se 

bodo tiskali v zelo kakovostnem digitalnem ali analognem tisku, vendar ne ustrezajo standardom 

ISO/PDF/X. Tu se skrbi predvsem za kar največjo kakovost upodobitev, zato dokumenti 

vključujejo vse možne informacije, ki so za to potrebne. Dokumenti temeljijo na formatu PDF 

1.4, vse barve se pretvorijo v barvni prostor izbranih procesnih barv CMYK, ločljivost je 300 ppi 

za barvne in večtonske slike, za enotonske slike pa 1200 ppi, vključene so vse pisave in 

transparence. 

Smallest File Size (glej sliko 37) je zadnji privzeti izbor nastavitev. Kot pove ime, se podatki 

skrčijo v največji možni meri za upodabljanje na spletu ali pošiljanje po elektronski pošti. 

Ločljivost dokumentov je razmeroma nizka, grafični elementi so stisnjeni, kolikor je mogoče. 

Vse pisave se vključijo, barve pa pretvorijo v izbran barvni prostor, običajno sRGB. 
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Potek dela 

Izberemo ukaz File→Export, v spustnem seznamu Save as Type izberemo funkcijo Adobe PDF 

in izberemo primeren format PDF. S pomočjo nastavitev, ki so nam na voljo v levem delu 

pogovornega okna Export Adobe PDF, lahko določimo še dodatne lastnosti izvoza. Prva 

funkcija je General (glej sliko 34), v polju Pages določimo, koliko strani dokumenta bomo 

izvozili. Če želimo izvoziti vse strani potrdimo funkcijo All, sicer v polje Range vnesemo 

številke strani, ki jih želimo izvoziti. S potrditvijo funkcije Spreads bo na eni strani izdelan 

dvostranski dokument, in sicer v primeru, da smo tako določili na začetku izdelave novega 

dokumenta (Facing Pages). Polje Options služi za prikaz izvoza, s potrditivjo funkcije View 

PDF after Exporting se takoj po izdelavi odpre dokument v programu Adobe Acrobat ali Adobe 

Reader (glej sliko 36). V polju Include so funkcije, ki jih potrdimo, kadar izvažamo v format 

PDF z dinamično vsebino (ko izdelamo zaznamke, dodamo zvok, video ...). Funkcije so aktivne 

samo, če v spustnem seznamu Adobe PDF Preset izberemo High Quality Print, Press Quality ali 

Smallest File Size. S funkcijo Compression lahko spremenimo stiskanje (kompresiranje) 

podatkov med izvozom. Primerna je za poznavalce, drugi pa naj raje obdržijo privzete 

nastavitve. Funkcija Marks And Bleeds (glej sliko 35) je namenjena dodajanju tiskarskih oznak 

in dodatkov na tiskano stran. Funkcija Output je namenjena barvnemu nadzoru pri izvažanju 

dokumenta Adobe PDF, pogovorno okno se spreminja glede na vrsto izbranega formata PDF. 

Primerna je za poznavalce, drugi pa naj raje obdržijo privzete nastavitve. Možnosti v oknu 

funkcije Advance se spreminjajo glede na izbrano vrsto formata PDF. Katera polja bomo 

spremenili, je odvisno od značilnosti delovnega procesa (Workflow), zato spremembe opravimo 

le v dogovoru s poznavalci, drugi naj raje uporabijo privzete nastavitve. Funkcijo Security 

uporabimo, kadar želimo zaščititi svoj dokument. Funkcije so aktivne samo, če v polju Adobe 

PDF Preset v spustnem seznamu izberemo High Quality Print, Press Quality ali Smallest File 

Size. Zaščita temelji na geslih za odpiranje (Document Open Password) in urejanje dokumenta 

(Permissions). 

 

 

Slika 34: Funkcija General (vir: Molek, I. za Učno gradivo). 
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Slika 35: Funkcija Marks and Bleeds (vir: Molek, I. za Učno gradivo). 

 

Slika 36: Prikaz strani izdelanega dokumenta PDF z oznakami za porezavo (vir: Molek, I. za 
Učno gradivo). 



   

 

48 

 

 

Slika 37: Nastavitve pri izdelavi PDF datoteke za splet z zaznamki in hiperpovezavami (vir: 
Molek, I. za Učno gradivo). 

 

Slika 38: Prikaz izdelanega dokumenta PDF z zaznamki (vir: Molek, I. za Učno gradivo). 
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MEDPREDMETNO POVEZOVANJE  

Povezava s slovenščino: 

Pomen jezika v stroki. 

Pravopis (raba velikih in malih črk, pisanje prevzetih besed, raba ločil, pisanje skupaj 

oziroma narazen, deljenje). 

Oblikoslovje. 

Uradovalna besedila, reklamno besedilo. 

Povezava z matematiko: 

Geometrija v ravnini. 

Povezava s tujim jezikom: 

Izdelava slovarja strokovnih izrazov. 

Branje in razumevanje strokovne literature v tujem jeziku. 

Iskanje spletnih dokumentov s pomočjo ključnih besed, zapisanih v tujem jeziku. 

Povezava z umetnostjo 

Prostorsko oblikovanje in vizualne komunikacije. 

Povezava z grafičnim oblikovanjem: 

Osnovni likovni elementi. 

Oblikovanje likovne kompozicije z uporabo likovnih spremenljivk in načel likovnega reda - 

povezovanje črke in oblike. 

Realizacija lastne oblikovalske zamisli in ocenjevanje kvalitete lastnega likovnega dela ter 

dela grafičnega oblikovanja nasploh (povezuje ploskev, volumen, prostor, obliko in 

funkcionalnost, razume pravila proporca ter obvlada enotnost v grafičnem oblikovanju). 

Barvni krog, barvno telo, psihološki vplivi barve. 

Povezava z grafičnimi in medijskimi procesi: 

Komuniciranje in vizualno komuniciranje. 

Naravoslovje tehnoloških procesov. 

Grafični proces. 

Povezava z informacijsko-komunikacijsko tehnologijo: 

Informacijski sistem in informacijska pismenost. 

Uporaba programov za organizacijo besedil, podatkov, datotek in map. 

Različna računalniška omrežja in elektronske komunikacije. 

Programski paket za urejanje besedil MS WORD (pisanje, oblikovanje in tiskanje besedil, 

vnos slik, tabel in grafikonov v besedilo). 

Elektronske preglednice (programski paket MS EXCEL), uporaba formul, ustvarjanje 

različnih tabel in grafikonov). 

Povezava s tipografijo in reprodukcijo: 

Razvoj pisave, črkovni slogi, tipografska pravila in osnove stavljenja. 

Predloge za reprodukcijo. 
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Delo s programi za obdelavo vektorske grafike. 

Digitalna obdelava slikovnega gradiva. 

Osnove programa za prelom strani. 

Povezava z izražanjem s sliko in zvokom 

Osnove fotografije, fotografska kompozicija. 
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